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2 About Your Product

About Your Product

After you set up your XP-800 (see the Start Here sheet), turn to this Quick Guide and your 
online User’s Guide for instructions on using your product.

Adjusting the Control Panel

The control panel is adjustable. Raise or lower it to the desired angle as shown.

Using the Touch Screen

The touch screen makes it easy to use all the features of your product. To save energy, the 
screen goes dark after several minutes of inactivity. Touch the screen to wake it up.

Features Where to find information

Copy, scan, and fax from the easy-to-use touch 
screen.

See this Quick Guide for the basics.
See the online User’s Guide for details.

Easy networking—WiFi, Wi-Fi Direct, and 
Ethernet®.

See the Start Here sheet and the online 
User’s Guide.

Process large documents with the 30-page 
capacity Automatic Document Feeder

See this Quick Guide for the basics.
See the online User’s Guide for details.

Print photos from a USB flash drive, external 
hard drive, or CD burner.

See the online User’s Guide for details.

Copy files to and from your computer with the 
built-in memory card reader.

Print on card stock and other thick media using 
the rear paper feed slot.

See this Quick Guide for the basics.
See the online User’s Guide for details.

Print and scan from anywhere with EPSON 
Connect™ Solutions, and Google Cloud Print™.

See www.epson.com/connect and the 
online User’s Guide for details.
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About Your Product 3

The touch screen displays only the buttons that are available for the task you are working 
on.

Caution: Press the touch screen gently with the tip of your finger; don’t press too hard 
or use sharp objects.

Tip: To turn off the “beep” heard when you press a button, or to reduce its volume, 
press Setup > Printer Setup > Sound and adjust one of the settings. If you turn off the 
sound, the dialing sound made when you transmit a fax is also turned off.

Note: The light is green when the product is connected to a network. It flashes 
when network settings are being adjusted (green for wireless and orange for wired).

For more information on the icons displayed on the screen, press l or r, then select Help 
on the product’s touch screen.

Number Description

1 Turns product on/off

2 Returns to the Home menu

3 LCD screen shows menus and status

4 Use the arrow keys to navigate menus

5 Shows wireless network status

6 Opens the CD/DVD menu

7 Cancels/returns to the previous menu

8 Starts copying/printing/scanning/faxing

2 3 4

765

1

8
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4 Loading Paper

Loading Paper

Your printer has two paper cassettes and a rear paper feed slot. You can load the following 
paper sizes:

■ Upper cassette (Cassette 1): 4 × 6- or 5 × 7-inch photo paper

■ Lower cassette (Cassette 2): letter-size, A4, legal-size, 4 × 6-, 5 × 7-, or 8 × 10- inch 
paper

■ Rear paper feed slot: one sheet at a time

For details on loading paper in the lower cassette, see the Start Here sheet. To load paper in 
the upper cassette or rear paper feed slot, follow the instructions in this section.

Loading Paper in the Upper Cassette

1. Open the front cover. If the output tray is open, close it before going to the next step. 
(As you slide in the output tray, there may be slight resistance and noise. This is 
normal.)

Upper
cassette

Lower
cassette

Rear paper feed slot
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Loading Paper 5

2. Pull out the upper paper cassette.

Note: If you do not see the upper cassette, it may be pushed into the printer. 
Remove the lower cassette, then carefully pull out the upper cassette.

3. Slide the edge guides outward.

4. Set the front edge guide to the paper size you are using. Then insert paper with the 
glossy or printable side facedown. Make sure the paper is loaded against the front edge 
guide.
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6 Loading Paper

5. Slide the side edge guides against the paper, but not too tight. Make sure the paper is 
under the tabs on the edge guides.

6. Keep the cassette flat as you insert it. Insert the cassette until the arrows on the right 
side line up.

Loading Paper in the Rear Feed Slot

First, send your print job to the printer. Be sure to select Rear Paper Feed Slot for the 
Source setting. (The print job can be sent from a computer or by using the touch screen.) 
Then follow the steps below to load paper in the rear paper feed slot.

1. Open the rear paper feed slot cover and pull up the paper support.

2. Slide the edge guides outward.
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Loading Paper 7

3. Load a single sheet of paper with the printable side faceup at the center of the rear 
paper feed slot. Slide the edge guides against the paper, but not too tight.

Note: Push paper down until it meets resistance (about 2 inches [5 cm]) of the 
paper should be inside the printer as shown).

4. When you’re ready to print, press x.

To cancel printing, press y Cancel.
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8 Loading Paper

Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of 
your documents, photos, presentations, and creative projects.

You can purchase genuine EPSON ink and paper at EPSON® Supplies Central® at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an EPSON authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Paper name Size

Part 

number

Sheet 

count

EPSON Bright White Paper Letter (8.5 × 11 inches 
[216 × 279 mm])

S041586 500

EPSON Brochure & Flyer Paper 
Matte Double-sided

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042384 150

EPSON Ultra Premium Presentation 
Paper Matte

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041341 50

EPSON Premium Presentation 
Paper Matte

8 × 10 inches (203 × 254 mm) S041467 50

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041257
S042180

50
100

EPSON Premium Presentation 
Paper Matte Double-sided

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041568 50

EPSON Presentation Paper Matte Letter (8.5 × 11 inches 
[216 × 279 mm])

S041062 100

Legal (8.5 × 14 inches 
[216 × 356 mm])

S041067 100

EPSON Ultra Premium Photo Paper 
Glossy

4 × 6 inches (102 × 152 mm) S042181
S042174

60
100

5 × 7 inches (127 × 178 mm) S041945 20

8 × 10 inches (203 × 254 mm) S041946 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042182
S042175

25
50

EPSON Ultra Premium Photo Paper 
Luster

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041405 50

EPSON Premium Photo Paper 
Glossy

4 × 6 inches (102 × 152 mm) S041808
S041727

40
100

5 × 7 inches (127 × 178 mm) S041464 20

8 × 10 inches (203 × 254 mm) S041465 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042183
S041667

25
50

EPSON Premium Photo Paper 
Semi-gloss

4 × 6 inches (102 × 152 mm) S041982 40

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041331 20
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Loading Paper 9

Note: Media availability varies by country.

For additional paper loading instructions, see the Start Here sheet or online User’s Guide.

For best results:

■ Fan and align the edges of the paper before loading.

■ If the paper is curled, flatten it or curl it slightly in the opposite direction before 
loading. Printing on curled paper may cause ink to smear on your prints.

■ Load paper into the paper cassettes with the glossy or printable side facedown making 
sure the paper is under the edge guides. Load paper in the rear feed slot with the 
glossy or printable side faceup.

■ Always load paper short edge first and make sure the paper stack fits under the edge 
guides.

■ Make sure the paper is loaded against the edge guide and not sticking out from the 
end of the cassette.

■ Do not load more than the recommended number of sheets.

EPSON Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809
S042038

50
100

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041141
S041649
S041271

20
50
100

EPSON Photo Quality Self-adhesive 
Sheets

A4 (8.3 × 11.7 inches 
[210 × 297 mm])

S041106 10

EPSON Iron-on Cool Peel Transfer 
paper

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041153 10

Paper name Size

Part 

number

Sheet 

count
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10 Placing Originals for Copying, Scanning, or Faxing

Placing Originals for Copying, 
Scanning, or Faxing

Before you copy, scan, or fax, place your documents on the scanner glass or in the 
Automatic Document Feeder (ADF). Place photos on the scanner glass only.

Using the Scanner Glass

You can place a photo or a document up to letter-size (or A4-size) 
on the scanner glass.

1. Raise the document cover.

2. Place your original facedown on the scanner glass, with the 
bottom against the front-right corner.

3. Close the cover gently to keep your original in place.

Using the Automatic Document Feeder

You can place up to 30 letter- or A4-size sheets (single- or double-sided), or 10 legal-size 
sheets (single-sided only) in the ADF.

Caution: Make sure your originals are not creased or folded, and do not contain holes, 
staples, tape, or other materials that could obstruct the feeder.

1. Open the ADF paper support, and then slide out the output tray extension.
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Placing Originals for Copying, Scanning, or Faxing 11

2. Slide out the edge guide.

3. Fan the originals, then tap them on a flat surface to even the edges.

4. Insert the originals face up, top edge first. The ADF icon appears on the screen.

Note: If you’re using the Letter, 2-up Copy or A4, 2-up Copy layout, make sure the 
originals are loaded as shown below.

5. Slide the edge guide against the originals, but not too tight.
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12 Copying a Document or Photo

Copying a Document or Photo

Follow the steps in this section to  make color or black-and-white copies.

You can copy documents just like on a copy machine. If you use the Automatic Document 
Feeder (ADF), you can copy up to 30 sheets at a time.

1. Make sure paper is loaded in one of the paper cassettes (see page 4).

2. Place your original document on the scanner glass or in the ADF (see page 10).

Note: When you use the Copy function with originals loaded in the ADF, letter-size 
paper is automatically selected for your printed copies. If you copy a legal-size 
document, the image will be cropped. To copy a full legal-size document on letter-
size paper, scroll down and select Reduce/Enlarge. Then select Legal->Letter.

3. Press  if necessary, and select Copy. You see this 
screen:

4. Press + or – to select the number of copies you want 
(up to 99). Or press the number 1 to display the 
numeric keyboard, then select the number and press 
Done.

5. Select Color or B&W (black-and-white).

6. Scroll down to view additional copy settings.

7. Select a copy setting, then press u or d and select an 
option.

Note: To clear previously used copy settings, scroll 
down and select Clear All Settings. For more 
information about copy settings, see your online 
User’s Guide.
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Copying a Document or Photo 13

8. When you’re ready to copy, press x.

To cancel copying, press y Cancel.

Note: When printing two-sided, if ink on the front of the paper smears, select a longer 
Dry Time setting.
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14 Printing From a Memory Card

Printing From a Memory Card

Your printer lets you print photos directly from your digital camera’s memory card; just 
insert it into the memory card slot and you’re ready to print.

See the online User’s Guide for a list of compatible memory cards and instructions on 
copying memory card files between your printer and a computer.

Inserting the Card

1. Make sure your printer is turned on.

2. Insert your card into the correct slot as 
shown. Insert just one card at a time.

Caution: Do not force the card into the 
slot; it won’t go in all the way. If your 
memory card requires an adapter, attach 
it before inserting the card into the slot. 
Otherwise, the card might get stuck.

The memory card access light flashes, then stays lit. Now you can view your photos on the 
LCD screen and print them (see page 15).

Removing the Card

After you finish printing your photos, follow these steps to remove the card:

1. Make sure the memory card access light is not flashing.

Caution: Do not remove the card or turn off your printer while the memory card 
access light is flashing; you may lose data on the card.

2. If the printer is connected to your computer with a USB cable, do one of the 
following before removing the memory card or turning off the printer:

■ Windows: Right-click the name of your card (removable disk) in Computer, My 
Computer or Windows Explorer, and select Eject.

■ Mac OS X: Drag the removable disk icon from your desktop into the trash.

3. Pull the card straight out of its slot.

Memory card 
access light
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Printing From a Memory Card 15

Printing Photos From the LCD Screen

You can select individual photos for printing as you view them on the LCD screen. See the 
online User’s Guide for instructions on printing various types of layout sheets and 
personalized note paper.

1. Load several sheets of EPSON photo paper (various types available; see page 8).

2. Press  if necessary, and select Print Photos.

3. Touch a photo on the screen to select it for printing.

4. Press + or – to select the number of copies you want of 
that photo.

To crop or zoom into a photo, select Edit > Crop/
Zoom, then make your adjustments.

To adjust the photo image, select Edit > Photo 
Adjustments, then make your adjustments.

5. To select another photo, press l or r to scroll through your photos, or press y and 
select a thumbnail image.

6. To choose print settings, select Settings. Then scroll down and change additional 
print settings, as necessary.

7. When you’re ready to print, press x.

To cancel printing, press y Cancel.
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16 Printing From Your Computer

Printing From Your Computer

This section describes the basic steps for printing from a Windows® or Mac computer. For 
detailed instructions on printing, including two-sided printing on plain paper or EPSON 
Bright White Paper with the auto duplexer, see the online User’s Guide.

Printing in Windows

1. Select the print command in your application.

2. Select your product, then click the Preferences or Properties button.

(If you see a Setup, Printer, or Options button, click it. Then click Preferences or 
Properties on the next screen.)

Click here to open 
your printer software

Select your EPSON 
product
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Printing From Your Computer 17

3. On the Main tab, select the basic print settings. Make sure you choose the correct 
paper Source and Type setting for the paper you are using (see page 19 for details).

Tip: For quick access to the most common settings, click the Shortcuts tab and 
select one of the Printing Presets. You can create your own presets by clicking the 
Add/Remove button.

4. To resize your printout or select other print settings, click the Page Layout tab and 
select settings as necessary.

5. For more printing options, click the Advanced tab.

Note: For more information about print settings, click Help or see your online 
User’s Guide.

6. Click OK to save your settings.

7. Click OK or Print to start printing.

Select your 
document or photo 
Orientation

Select your 
paper Size

Select your 
paper Type 

Select the type of document you’re 
printing (choose Photo or Best 
Photo for pictures)

Select the 
correct Source 
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18 Printing From Your Computer

Printing with Mac OS X

Follow the steps below to print from Mac OS X.

1. Open a photo or document in an application.

2. Open the File menu and select Print.

3. Select your EPSON product as the Printer setting.

4. Click the arrow or Show Details to expand the print window, if necessary.

5. Select basic copy and page settings. For borderless printing, choose a Paper Size 
setting with a Borderless option.

Note: If the setting you want isn’t shown (for example, Scale), check for it in your 
application before printing. Or select your application from the pop-up menu in this 
window and check if the setting is available.

Select your EPSON product

Copy and page 
settings

Application 
settings

Pop-up menu
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Printing From Your Computer 19

6. Choose Print Settings from the pop-up menu, and select your Media Type, Print 
Quality, and other print settings.

7. Choose any other printing options you may need from the pop-up menu. See the 
online User’s Guide for details.

8. Click Print.

9. To monitor your print job, click the printer icon in the Dock.

Selecting the Correct Paper Type

Select the correct Type (Windows) or Media Type (Mac OS X) setting in your printer 
software. This tells your product what kind of paper you’re using, so the ink coverage can 
be adjusted accordingly. 

For this paper Select this setting

Plain paper
EPSON Bright White Paper
EPSON Presentation Paper Matte
EPSON Iron-on Cool Peel Transfer paper
EPSON Photo Quality Self-adhesive Sheets

Plain Paper/Bright White Paper

EPSON Premium Photo Paper Glossy Premium Photo Paper Glossy

EPSON Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy

EPSON Photo Paper Glossy Photo Paper Glossy

EPSON Premium Photo Paper Semi-gloss
EPSON Ultra Premium Photo Paper Luster

Premium Photo Paper Semi-Gloss

EPSON Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte 

Double-sided
EPSON Ultra Premium Presentation Paper Matte
EPSON Brochure & Flyer Paper Matte Double-sided

Premium Presentation Paper Matte

Envelopes Envelope
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20 Faxing a Document

Faxing a Document

Your product lets you send faxes by entering fax numbers or selecting entries from a speed 
dial or group dial list. Using the Automatic Document Feeder (ADF), you can fax up to 30 
pages at a time.

Note: You can also send and receive a fax from your computer using the EPSON FAX 
Utility. For more information, see the online User’s Guide.

Breakdown or repair of this product may cause loss of fax data and settings. Epson is 
not responsible for backing up or recovering data and settings during or after the 
warranty period. We recommend that you make your own backup or print out your fax 
data and settings.

This product allows you to store names, telephone numbers, and fax data in its memory 
even when the power is turned off. Use the following procedure to erase the memory if 
you give away or dispose of the product: Press  if necessary, press l or r to select 
Setup > Restore Default Settings > All Settings. This procedure will erase all of your 
network settings and fax data.

Connecting a Phone or Answering Machine

1. Connect the phone cable from the wall 
jack to the LINE port on the back of the 
product.

Note: If you’re connecting the product 
to a DSL phone line, you must plug a 
DSL filter into the wall jack or you won’t 
be able to use the fax or telephone 
equipment. Contact your DSL provider 
for the necessary filter.

2. To use a telephone or answering machine 
on the same line, you need a second 
phone cable. Remove the cap from the 
EXT. port on the back of the product. 
Connect one end of the cable to the 
telephone or answering machine, and 
connect the other end to the EXT. port.

Note: Set the printer ringer to answer 
one ring after the answering machine.

Telephone wall jack

Telephone wall jack
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Faxing a Document 21

In Auto Answer mode, if the incoming call is a fax and you pick up the phone or the 
answering machine answers, the product automatically begins receiving the fax. If the 
other party is a caller, the phone can be used as normal or a message can be left on the 
answering machine.

Note: Any phone or answering machine must be connected to the EXT. port for your 
product to detect an incoming fax call when the phone is picked up. Epson cannot 
guarantee compatibility with VoIP, cable phone systems, or fiberoptic digital services such 
as FiOS™.

Setting Up Fax Features

Before sending or receiving faxes, you should create a fax header and select the number of 
rings before the fax answers.

Note: To select other settings or use the EPSON FAX Utility, see the online User’s 
Guide.

Entering Fax Header Information

You should enter your name and phone number in the fax header before sending faxes so 
that recipients can identify the origin of the fax.

Note: If you leave your product unplugged for a long period of time, the date and time 
settings may get lost. See the online User’s Guide for instructions on resetting them.

Entering Your Sender Name

1. Press  if necessary, then press l or r and select Setup.

2. Scroll down and select Fax Settings.

3. Select Communication.

4. Scroll down and select Header.

5. Select Fax Header. You see the Fax Header screen.

6. Use the keypad to enter the header information. You 
can enter up to 40 characters or digits for your name 
and other contact information.

To enter text, press a keypad number repeatedly to 
switch between uppercase, lowercase, or numbers.

7. Press Done to return to the Header menu.
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22 Faxing a Document

Entering Your Phone Number

1. Select Your Phone Number from the Header menu.

2. Use the keypad to enter your phone number, up to 20 
digits. You don’t need to use dashes.

■ To delete a character, press .

■ To type the + symbol for an international 
number, press #. 

3. Press Done to return to the Header menu.

Selecting the Number of Rings to Answer

If you connected an answering machine and it is set to pick up on the fourth ring, you 
should set the product to pick up on the fifth ring or later. Otherwise, your answering 
machine will not be able to pick up incoming calls.

1. Press  if necessary, then press l or r to select Setup.

2. Scroll down and select Fax Settings.

3. Select Communication, then Rings to Answer.

4. Press + or – to select the number of rings, then press Done.

Note: Set the fax to answer one ring after the answering machine.

Sending a Fax From the Control Panel

You can send a fax by manually entering a fax number, as described below.

Note: To dial the number using a telephone, by redialing, or by selecting from your 
speed dial or group dial list, see the next section. To send a fax from your computer 
using the EPSON FAX Utility, see your online User’s Guide.

1. Place your original(s) for faxing (see page 10).

2. Press  if necessary, then select Fax.

To fax a two-sided document, place your document 
in the ADF. Scroll down on the fax screen and select 
2-sided Faxing, then select On.

3. Press Enter Fax Number, then use the numeric 
keypad to enter the fax number (up to 64 digits). 
Then press Done.
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Faxing a Document 23

4. Scroll down to select Color or B&W.

If necessary, scroll down and change any other fax settings.

5. Press OK, if desired, to see a summary of your fax transmission settings.

6. Press x to begin scanning and faxing your document. (To cancel, press y Cancel.)

■ You can select 2-Sided Faxing even if the recipient’s fax machine does not print 
2-sided.

■ If the recipient’s fax machine prints only in black and white, your fax is 
automatically sent in black and white even if you select Color.

■ If you are scanning with the ADF (see page 10), your document is automatically 
scanned and faxed.

■ If you placed your document on the scanner glass, you can scan additional pages 
after the first one is sent.

■ If the fax number is busy, you see a redialing message and the product redials 
after one minute. To redial immediately, press Redial.

Note: If you turn off the product, the following data stored in the product’s temporary 
memory will be lost: received faxes that haven’t yet been printed, faxes scheduled to 
be sent later, and faxes being retransmitted automatically.

Receiving Faxes

Before receiving faxes, make sure you load plain paper and select the correct settings for the 
paper you’ve loaded.

1. Press  if necessary, then press l or r and select Setup.

2. Scroll down and select Fax Settings.

3. Select Receive Settings.

4. To receive faxes automatically, select Auto Answer, then select On.

5. Select the Paper Size and Paper Source you want to use for printing faxes.

Note: If the incoming fax is larger than the paper you loaded, it is reduced to fit or 
printed on multiple pages, depending on the Auto Reduction setting you select.

Note: To change the number of rings before the product answers, see page 22.

If you run out of paper during printing, you see an error message. Load more paper and 
press x to continue.

Note: To manually receive a fax, see your online User’s Guide.
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24 Scanning a Document or Photo

Scanning a Document or 
Photo

You can use your product to scan original documents or photos and save them on your 
computer.

Note: For detailed scanning instructions, see the online User’s Guide.

Quick Scanning with the Touch Screen

Use the touch screen to quickly scan a photo or document and save it on your computer. 
You can even scan and send the image or document to an online service or to a remote 
printer.

1. Place your original document or photo as shown on page 10. For 2-sided scanning, 
place your document in the ADF.

2. Press  if necessary, then select Scan.

3. Scroll up or down and select one of the following options:

■ Scan to Memory Card automatically scans a photo or document and saves it to 
an inserted memory card or USB storage device.

■ Scan to Cloud sends your scanned files to a destination that you have registered 
with EPSON Connect.

■ Scan to PC automatically creates a JPG image and saves it to your computer; 
ideal for scanning photos.

■ Scan to PC (PDF) automatically creates a PDF file and saves it to your computer; 
ideal for scanning documents.

■ Scan to PC (Email) automatically scans a photo, resizes it, launches your email 
application, and attaches a JPG image to a new outgoing message. This works 
with MAPI-type email such as Microsoft® Outlook or Windows Live Mail, but 
not web-based email such as Gmail.

■ Scan to PC (WSD) lets you manage network scanning in Windows 7 or 
Windows Vista® (English only). To use this feature, you must first set up WSD 
(Web Services for Devices) on the computer.
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4. If you’re scanning to a memory card or USB storage device, select your scan settings 
then press x to begin scanning.

If you’re scanning to your computer, select USB Connection if your product is 
connected by a USB cable, or select the name of your computer if your product is 
connected over a network. Press x to begin scanning.

Once your image is scanned, you see its icon on your computer screen, or as an 
attachment in your email application.

Scanning with EPSON Scan Software

You can scan original documents and photos and save them as files on your computer 
using the EPSON Scan software. You can also launch EPSON Scan from any TWAIN-
compliant application.

Note: For Mac OS X 10.6 or 10.7, see “Scanning with Mac OS X 10.6 or 10.7” on 
page 26. For detailed scanning instructions, see the online User’s Guide.

1. Place your original document or photo as shown on page 10. For 2-sided scanning, 
place your document in the ADF.

2. Do one of the following to start EPSON Scan:

■ Windows: Double-click the EPSON Scan icon on your desktop.

■ Mac OS X 10.5: Double-click EPSON Scan in Applications > Epson 
Software.

■ To scan from an application, start your application. Then open the File menu, 
choose Import or Acquire, and select your EPSON product.
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EPSON Scan opens in Office Mode the first time you use it. (You can change the 
scan mode using the Mode selector in the upper right corner.)

Note: You cannot use Home mode to scan with the Automatic Document Feeder.

3. Click Scan. The image is scanned and you see its icon in the folder you have selected.

Scanning with Mac OS X 10.6 or 10.7

You can scan original documents and photos and save them as files on your computer.

1. Place your original document or photo as shown on page 10. For 2-sided scanning, 
place your document in the ADF.

2. Open an image editing application such as Image Capture and select your product 
from the DEVICES or SHARED list, if necessary.

3. In the Mode pop-up menu, select the setting indicating where you placed your 
original.

4. If you would like to select scan settings, such as Color Restoration and file save 
settings, click Show Details.

5. In the Scan To pop-up menu, select the folder in which you want to save your image.

Click here to change 
the scan mode
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6. Click the Scan button to begin scanning. Your image is saved to the folder selected.

Note: With Mac OS X 10.6 or 10.7, in addition to scanning with Image Capture, you can 
download and install EPSON Scan scanning software. EPSON Scan provides additional 
image adjustment and photo correction features for enhancing scanned images, and 
provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY® 
FineReader®. To download EPSON Scan, visit Epson’s driver download site 
epson.com/support (U.S.) or epson.ca/support (Canada).
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Maintaining Your Product

Follow the instructions in this chapter to check and clean the print head nozzles, check ink 
levels, and replace ink cartridges. If you need to align the print head, see the online User’s 
Guide.

Caution: To keep your product looking like new, don’t place anything on top of the 
cover or use it as a writing surface. If you need to clean the cover, use only a soft, 
non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may 
be clogged or ink may be running low in one or more of the ink cartridges. Follow the 
steps below to check the print head nozzles.

1. Load a few sheets of plain paper in the lower paper cassette (cassette 2).

2. Press  if necessary, press l or r, then select Setup.

3. Select Maintenance, then Nozzle Check.

4. Press x. The nozzle check is printed.

5. Check the printed pattern to see if there are gaps in the lines:

6. If there are no gaps, the print head is clean. Select Done.

If there are gaps or the pattern is faint, select Clean the Print Head.Then follow the 
instructions on the screen to clean the print head (see page 29).

Nozzles 
are clean

Nozzles need 
cleaning
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Cleaning the Print Head

If print quality has declined and the nozzle check indicates clogged nozzles, you can clean 
the print head. Print head cleaning uses ink, so clean it only if necessary.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be 
able to clean it when a cartridge is low. You must replace the cartridge first (see 
page 31).

1. Load a few sheets of plain paper in the lower paper cassette (cassette 2).

2. Press  if necessary, press l or r, then select Setup.

3. Select Maintenance, then Head Cleaning.

4. Press x.

Cleaning takes a few minutes. When it’s finished, you see a message on the display 
screen.

Caution: Never turn off the printer during head cleaning or you may damage it. Do 
not open the scanner unit or insert the CD/DVD tray during head cleaning.

5. Select Print Nozzle Check Pattern, then press x to run a nozzle check and confirm 
that the print head is clean.

6. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle 
and check the nozzles again.

Note: If you don’t see any improvement after cleaning the print head four times, leave 
the printer on and wait at least six hours to let any dried ink soften. Then try cleaning 
the print head again. If quality does not improve, one of the ink cartridges may need to 
be replaced. If that doesn’t help, contact Epson as described on page 42.

If you do not use your printer often, it is a good idea to print a few pages at least once a 
month to maintain good print quality.

Checking Ink Levels

You can check the ink levels anytime right on the LCD screen. To check the ink levels with 
your Windows or Mac OS X software, see the instructions in your online User’s Guide.

Note: You cannot print or copy when an ink cartridge is expended even if the other 
cartridges are not expended. Replace any expended cartridges before printing or 
copying.

1. Press  if necessary, then press l or r and select Setup.

2. Select Ink Levels.

The ink cartridge status is displayed. See page 31 to replace a cartridge, if necessary.

3. Press OK to exit.
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In Windows, a window may appear on your computer screen when you try to print when 
ink is low. This window can optionally display ink offers and other updates from Epson.

Note: To disable checking for ink offers or updates from Epson, see the instructions in 
your online User’s Guide.

Purchasing EPSON Ink Cartridges

You can purchase genuine EPSON ink and paper from EPSON Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an EPSON authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges (you can mix 
Standard- and High-capacity cartridges):

Note: We recommend that you use genuine EPSON cartridges and do not refill them. 
The use of other products may affect your print quality and could result in printer 
damage.

Yields vary considerably based on images printed, print settings, paper type, frequency 
of use, and temperature. Actual yields will be lower with higher-density images, hot or 
dusty conditions, less frequent printing or printing predominantly with one color. All ink 
colors are used for printing and all-in-one printer maintenance, and all colors have to be 
installed for printing. For print quality, part of the ink from the included cartridges is 
used for printer startup and a variable amount of ink remains in the cartridges after the 
“replace cartridge” signal.

For best printing results, use up a cartridge within six months of opening the package, 
and before the expiration date on the cartridge box.

Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold 
temperatures, allow them to warm up to room temperature for at least 3 hours before 
using them.

Ink color Standard-capacity High-capacity

Photo Black 273 273XL

Black 273 273XL

Cyan 273 273XL

Magenta 273 273XL

Yellow 273 273XL
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Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges 
immediately after removing old ones.

Caution: Do not open ink cartridge packages until you are ready to install the ink. 
Cartridges are vacuum packed to maintain reliability.

Leave the expended cartridge installed until you have obtained a replacement, or the 
ink remaining in the print head nozzles may dry out.

Note: If you remove a low or expended ink cartridge, you cannot reinstall and use the 
cartridge.

1. Turn on your product.

2. If an ink cartridge is expended, you see a message on the LCD screen indicating which 
color to replace.

If you’re replacing a cartridge before you see a message on the LCD screen, select 
Setup > Ink Levels > Cartridge Replacement.

Note: If a cartridge is expended, you must replace it to be able to print. If a 
cartridge is low, you can continue printing until a cartridge needs replacement.

3. Lift up the scanner unit.

Caution: Do not move the print head by hand; otherwise, you may damage your 
product. Do not touch the flat white cable inside the printer.
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4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the 
bottom of the ink cartridge to remove it.

Warning: If ink gets on your skin, wash it off thoroughly with soap and water. If it 
gets in your eyes, flush them immediately with water. If you still have discomfort or 
vision problems, see a doctor immediately. Keep ink cartridges out of the reach of 
children and don't allow them to drink the ink.

5. Recap the ink cartridge using the cap that came with it. Dispose of it carefully. Do not 
take the used cartridge apart or try to refill it.

6. If you are replacing the Black (BK) ink cartridge, shake the new cartridge gently four 
or five times before unwrapping it. You do not need to shake the Photo Black (PBK) 
cartridge or any of the other color ink cartridges.
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7. Open the new ink cartridge package.

Caution: Do not touch the areas shown above. Doing so may prevent normal 
operation and printing.

Note: Do not shake cartridges after opening the package, as they may leak.

8. Remove the cap from the cartridge and store it in the included plastic bag for later 
use.

9. Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom 
of the ink cartridge down until it clicks into place.
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10. Once you replace all the cartridges that need replacing, close the scanner to begin 
priming the ink. This takes a few minutes. When you see a completion message on 
the LCD screen, ink priming is finished.

Caution: Never turn off your product while ink is priming or you’ll waste ink. If you 
see an ink replacement message on the LCD screen, lift the scanner unit and press 
down on all the cartridges firmly. If printing on a CD or DVD, do not insert the
CD/DVD tray until ink priming is finished.
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Solving Problems

If you have a problem with your EPSON product, check the messages on the LCD screen 
to diagnose the cause of most problems. Press  if necessary, then press l or r and select 
Help. Select Troubleshooting, then scroll up or down to see all the help topics.

Note: If the screen is dark, press the touch screen to wake the printer from sleep 
mode.

You can also check the basic troubleshooting suggestions below, or in your online User’s 
Guide. Or, access interactive troubleshooting and FAQs at epson.com/support (U.S.) or 
epson.ca/support (Canada).

Note: Breakdown or repair of this product may cause loss of fax and network data and 
settings. Epson is not responsible for backing up or recovering data and settings during 
or after the warranty period. We recommend that you make your own backup or print 
out your fax and network data and settings.

Network Problems

Note: For more detailed network instructions, see your online User’s Guide.

■ Try connecting to the wireless router or access point with your computer or another 
device to confirm that it is working correctly.

■ Try restarting the router (turn it off and then on), then try to connect to it again.

■ Print a Network Status Sheet (see page 37). Verify that the network settings are correct 
and check the signal strength. If it is poor, try moving the product closer to your 
router or access point. Avoid placing it next to a microwave oven, 2.4 GHz cordless 
phone, or large metal object such as a filing cabinet.

■ If your wireless router doesn’t broadcast its network name (SSID), see the following 
page for instructions on manually entering your wireless network name.

■ If your wireless router has security enabled, make sure you entered the WEP key or 
WPA passphrase correctly.

■ When using TCP/IP, make sure your network’s DHCP option is enabled (your router 
manufacturer will be able to assist you with this setting).

■ Remove and reinsert the CD to reinstall your product software.

■ Disable the firewall temporarily to see if that may be causing the problem. Contact 
your firewall manufacturer for assistance.
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Connect the Printer to Your Wireless Network

If you are unable to connect to your wireless network using the product CD and the Start 
Here sheet, you can use the touch screen on your product. Before you start, make sure you 
know your network name (SSID) and password.

1. Press  if necessary, then select Wi-Fi Setup on the touch screen.

2. Select Wi-Fi Setup Wizard.

3. Scroll down until you see the name of your wireless network, then select it. Continue 
with step 6.

If you don’t see your network name, select Other 
Networks. You see this screen:

4. Enter your network name (SSID).

■ Press the touch screen buttons repeatedly to scroll 
through characters.

■ If your network name has uppercase (ABC) or 
lowercase (abc) letters, make sure you enter them 
correctly.

■ Press  or  to move the cursor.

■ Press  to enter symbols.

■ Press  to delete.

5. Select Done when you’re finished entering your network name.

6. If your network has security enabled, you see the 
password screen:

7. Follow the instructions above to enter the password. If 
your network password has uppercase or lowercase 
letters, be sure to enter them correctly.

8. Select Done when you’re finished entering your 
password.

When the printer is connected to your network, the WiFi light should be green, and not 
flashing. Make sure you install the software on every computer from which you want to 
print. When prompted during software setup, select The printer is already on my 
wireless network.
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Cannot Scan Over the Network

■ EPSON Scan is not installed in Mac OS X 10.6 or 10.7; see page 26 for scanning and 
download instructions.

■ If you cannot scan from the product’s touch screen, make sure you restarted your 
computer after installing the product software. Make sure EPSON Event Manager is 
not being blocked by your firewall or security software. Try turning off the firewall.

■ If you are scanning a large document at high resolution, a communication error may 
occur. If the scan did not complete, lower the scan resolution.

■ If network communication was interrupted while starting EPSON Scan, exit EPSON 
Scan and restart it after a few seconds. If EPSON Scan cannot restart, turn the 
product off and on, and then try again. Check the Timeout Setting in EPSON Scan 
Settings. For details, see the EPSON Scan Help.

■ Make sure EPSON Event Manager is set up to communicate with your product.

Print a Network Status Sheet

1. Press  if necessary, press l or r, then select Setup.

2. Scroll up or down and select Wi-Fi/Network Settings.

3. Scroll up or down and select Wi-Fi/Network Status.

4. Select Print the status sheet, then press x.

Printing and Copying Problems

■ When loading paper in the paper cassettes, make sure it is loaded facedown (usually 
the whiter, brighter, or glossy side) and under the edge guides. When loading paper in 
the rear feed slot, make sure to load it face up.

■ Make sure the paper size and source selected on the touch screen or in your printer 
software is correct for the paper you loaded.

■ Letter-size paper is automatically selected for copying. If your legal-size document is 
cropped, scroll down and select Reduce/Enlarge, then select Legal->Letter.

■ When scanning, position your original with the bottom against the front right corner 
of the scanner glass. If the edges are cropped, move it away from the corner slightly.

■ You cannot print, copy, or receive faxes when an ink cartridge is expended. Replace 
any expended cartridges before printing.

■ To select two-sided printing in Mac OS X, choose 2-sided Settings from the pop-up 
menu. Do not select Layout from the pop-up menu.
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Paper Feeding Problems

■ If paper doesn’t feed correctly, remove the paper and fan the sheets, then reload them 
as shown on page 4. Make sure paper is loaded under the edge guides.

■ Do not load more than the recommended number of sheets. See your online User’s 
Guide for information on paper loading capacity.

■ If paper has jammed, follow the steps on the LCD screen. If necessary, check the 
following areas:

1. Carefully remove any jammed paper from the rear feed slot.

2. Lift the scanner unit and carefully remove any paper trapped inside.

3. Remove the paper cassettes, then remove any jammed paper trapped inside.
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4. Remove the auto-duplexer from the back of the printer and check for any 
jammed paper.

5. Remove any paper stuck in the auto-duplexer.

ADF Document Feeding Problems

If documents don’t feed correctly in the Automatic Document Feeder (ADF), make sure 
the paper is not bent, folded, or curled.

If paper has jammed:

1. Open the ADF cover and remove any jammed paper.
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2. If necessary, lift the scanner cover and remove the document mat. Then carefully 
remove any pages caught beneath it.

3. Open the ADF input tray and remove any jammed paper.

Caution: Do not try to remove the pages without opening the ADF cover or you could 
damage the mechanism.

Faxing Problems

■ Make sure the recipient’s fax machine is turned on and working.

■ Make sure the LINE port on the product is connected to a telephone wall jack. Verify 
that the telephone wall jack works by connecting a phone to it.

■ Make sure Auto Answer is on to receive faxes automatically (see page 23).

■ If the line has static, press  if necessary, then press l or r and select Setup. Scroll 
down and select Fax Settings, then Communication. Turn off the ECM (Error 
Correction Mode) setting.

■ If your phone line includes voicemail services, turn off Auto Answer. Otherwise, calls 
or faxes may be inadvertently received by your voicemail service.

■ If the product is connected to a DSL phone line, you must have a DSL filter 
connected to the phone jack. Contact your DSL provider for the necessary filter.
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■ If you connected a telephone or answering machine, make sure it is connected to the 
EXT. port. Do not use a phone line splitter.

■ If an answering machine is connected, set the number of rings to answer for receiving 
faxes to be greater than the number of rings for the answering machine.

Print Quality Problems

■ Load the paper printable side down (usually the whiter, brighter, or glossy side) in the 
paper cassettes. Load paper printable side up in the rear paper feed slot.

■ Make sure your paper isn’t damp or curled.

■ For the best print quality, use EPSON papers (see page 8) and genuine EPSON ink 
cartridges (see page 30).

■ Make sure the type of paper you loaded matches the paper type setting on the touch 
screen or in your printer software (see page 19).

■ If you notice light or dark bands across your printouts or they are too faint, run a 
nozzle check (see page 28) to see if the print head needs cleaning.

■ If you notice jagged vertical lines, you may need to align the print head. See the online 
User’s Guide for instructions.

■ The ink cartridges may be low on ink. Check your cartridge status and replace 
cartridges, if necessary (see page 31).

■ Clean the scanner glass with a soft, dry, lint-free cloth (paper towels are not 
recommended), or use a small amount of glass cleaner on a soft cloth, if necessary. Do 
not spray glass cleaner directly on the glass.
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Where to Get Help

Internet Support
Visit epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to common 
problems. You can download drivers and documentation, get FAQs and troubleshooting 
advice, or e-mail Epson.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (XP-800)

■ Product serial number (located on the back of the product and under the scanner)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and description of the problem

Then call: (562) 276-4382 (US) or (905) 709-3839 (Canada) 6 AM – 8 PM, Pacific Time, 
Monday through Friday, and 7 AM – 4 PM, Pacific Time, Saturday.

Days and hours of support are subject to change without notice. Toll or long distance 
charges may apply.

Purchase Supplies and Accessories
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an EPSON authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Other Software Technical Support
ABBYY FineReader
Phone: (408) 457-9777
www.abbyy.com
support@abbyyusa.com
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Notices

Important Safety Instructions

Before using your EPSON product, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the product.

■ Use only the type of power source indicated on the product label.

■ Use only the power cord that comes with the product. Use of another cord may cause fires or 
electric shock. Do not use the cord with any other equipment. Make sure the power cord meets 
all relevant local safety standards.

■ The product’s power cord is for use with the product only. Use with other equipment may 
cause fire or electric shock.

■ Place the product near a wall outlet where the plug can be easily unplugged.

■ If you won’t be using the product for a long period, unplug the power cord from the electrical 
outlet.

■ Always turn off the product using the P power button, and wait until the P power light stops 
flashing before unplugging the product or cutting off power to the electrical outlet.

■ Avoid plugging the product into an outlet on the same circuit as a photocopier or air 
conditioning system that regularly switches on and off, or on an outlet controlled by a wall 
switch or timer.

■ Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, 
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or 
run over. Be careful to keep the cord straight at each end. If damage occurs to the plug, replace 
the cord or consult a qualified electrician. If there are fuses in the plug, make sure you replace 
them with fuses of the correct size and rating.

■ If you use an extension cord with the product, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the 
total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s 
ampere rating.

■ When connecting the product to a computer or other device with a cable, ensure the correct 
orientation of the connectors. Each connector has only one correct orientation. Inserting a 
connector in the wrong orientation may damage both devices connected by the cable.

■ Place the product on a flat, stable surface that extends beyond its base in all directions. It will 
not operate properly if it is tilted or at an angle.

■ Avoid placing the product in locations that are subject to rapid changes in heat or humidity, 
shocks or vibrations, or dust. Do not place the product near a radiator or heating vent or in 
direct sunlight. Do not place or store the product outdoors.

■ Keep the product away from potential sources of electromagnetic interference, such as 
loudspeakers or the base units of cordless phones.
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■ Allow space behind the product for the cables, and space above the product so that you can 
fully raise the document cover.

■ Leave enough space in front of the product for the paper to be fully ejected.

■ Leave enough room around the product for sufficient ventilation. Make sure the product is at 
least 4 inches (10 cm) away from the wall.

■ Do not block or cover openings in the product case or insert objects through the slots.

■ Do not use aerosol products that contain flammable gases inside or around the product. Doing 
so may cause fire.

■ Do not press too hard on the scanner glass when placing the originals.

■ Do not open the scanner section while the product is faxing, copying, printing, or scanning.

■ Be careful not to trap your fingers when closing the scanner cover or scanner.

■ Do not touch the flat white cable inside the product.

■ Do not spill liquid on the product. Do not use the product near water. Do not use with wet 
hands.

■ Unplug the product and refer servicing to qualified service personnel under the following 
conditions: if the power cord or plug is damaged; if liquid has entered the product; if the 
product has been dropped or the case damaged; if the product does not operate normally or 
exhibits a distinct change in performance.

■ Adjust only those controls that are covered by the operating instructions. Except as specifically 
explained in your documentation, do not attempt to service the product yourself.

■ Never disassemble, modify, or attempt to repair the product by yourself, except as specifically 
explained in the documentation. Do not adjust controls that are not covered by the operating 
instructions.

■ When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside 
down; otherwise ink may leak from the cartridges.

■ Always keep this guide handy.

Touch Screen Safety

■ Press the touch screen gently with your fingertip. Do not press with force or use your fingernail.

■ The LCD screen may contain a few small bright or dark spots or uneven brightness. This is 
normal and does not indicate that the touch screen is damaged in any way.

■ Use only a dry, soft cloth to clean the touch screen. Do not use liquid or chemical cleansers.

■ Do not use items such as ball point pens, pencils, etc. to operate the touch screen.

■ Do not touch the screen with wet or gloved hands or through the protective sheet or sticker; it 
may not respond.

■ Do not place heavy items on the touch screen. Contact Epson if the panel chips or cracks; do 
not attempt to remove broken pieces.

■ Do not place your product in areas where abrupt changes in temperature or humidity may 
occur. Condensation inside the screen may cause performance to deteriorate.
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■ If the touch screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, 
wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, 
flush them immediately with water. If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

Memory Card Safety

■ Use only compatible memory cards (see the User’s Guide for a detailed list).

■ Do not remove a memory card or turn off the product while the memory card light is flashing.

Wireless Network Safety

■ Do not use this product inside medical facilities or near medical equipment. Radio waves from 
the product may adversely affect the operation of medical equipment.

■ Do not use this product near automatically controlled devices such as automatic doors or fire 
alarms. Radio waves from this product may adversely affect these devices.

■ To avoid adversely affecting the operation of the following equipment and causing an accident, 
do not use the product: near medical equipment in a medical facility; within 8.7 inches (22 cm) 
of a cardiac pacemaker; near automatically controlled devices, such as automatic doors or fire 
alarms.

Ink Cartridge Safety

■ Keep ink cartridges out of the reach of children and don’t allow them to drink the ink.

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink 
supply port. If ink gets on your skin, wash it off thoroughly with soap and water. If it gets in 
your eyes, flush them immediately with water. If you still have discomfort or vision problems, 
see a doctor immediately. If ink gets in your mouth, spit it out and see a doctor right away.

■ Do not put your hand inside the product or touch any cartridges during printing.

■ Do not try to move the print head by hand, or you may damage the product.

■ Do not touch the green IC chip on the side of the cartridge. This may prevent normal 
operation.

■ Before transporting the product, make sure the print head is in the home (far right) position 
and the ink cartridges are in place.

■ Install a new ink cartridge immediately after removing a used one. Leaving cartridges 
uninstalled can dry out the print head and may prevent the product from printing.

■ Do not dismantle an ink cartridge. This could damage the print head.

■ Use the ink cartridge before the date printed on its package.

■ If you remove an ink cartridge for later use or disposal, make sure you put the cap back on the 
cartridge’s ink supply port to prevent ink from drying out or to prevent surrounding areas from 
getting smeared by ink.
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■ Store ink cartridges in a cool, dry place.

■ After bringing an ink cartridge in from a cold storage site, allow it to warm up at room 
temperature for at least 3 hours before using it.

■ Although the ink cartridges may contain recycled materials, this does not affect product 
function or performance.

Telephone Equipment Safety

When using telephone equipment, you should always follow basic safety precautions to reduce the 
risk of fire, electric shock, and personal injury, including the following:

■ Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock 
from lightning.

■ Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication 
line cord.

Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU 
Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13

3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the 
representative unit tested and found to be compliant with the standards. Records maintained 
continue to reflect the equipment being produced can be expected to be within the variation 
accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. 
Operation is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C492B
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FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the surface of this equipment is a 
label that contains, among other information, a product identifier in the format 
US:AAAEQ##TXXXX. If requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes (USOC) for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It is designed to be connected to a 
compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. 
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming 
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the 
number of devices that may be connected to a line, as determined by the total RENs, contact the 
local telephone company. For products approved after July 23, 2001, the REN for this product is 
part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by 
## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is 
separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in 
advance that temporary discontinuance of service may be required. But if advance notice isn’t 
practical, the telephone company will notify the customer as soon as possible. Also, you will be 
advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that 
could affect the operation of the equipment. If this happens the telephone company will provide 
advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit 
www.epson.com for more information. This product is not intended to be repaired by the customer. 
If you experience trouble connecting this equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that 
you disconnect the equipment until the problem is resolved.

This equipment may not be used on coin service provided by the telephone company. Connection to 
party line service is subject to state tariffs. Contact the state public utility commission, public service 
commission or corporation commission for information.
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If your home has specially wired alarm equipment connected to the telephone line, ensure the 
installation of this equipment does not disable your alarm equipment. If you have questions about 
what will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a 
computer or other electronic device, including fax machines, to send any message unless such 
message clearly contains in a margin at the top or bottom of each transmitted page or on the first 
page of the transmission, the date and time it is sent and an identification of the business or other 
entity, or other individual sending the message and the telephone number of the sending machine or 
such business, other entity, or individual. (The telephone number provided may not be a 900 
number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, follow the instructions in “Entering Fax 
Header Information” on page 21.

According to the FCC’s electrical safety advisory, we recommend that you may install an AC surge 
arrestor in the AC outlet to which this equipment is connected. Telephone companies report that 
electrical surges, typically lightning transients, are very destructive to customer terminal equipment 
connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to 
radio and television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING 

The connection of a non-shielded equipment interface cable to this equipment will invalidate the 
FCC Certification of this device and may cause interference levels which exceed the limits 
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not 
expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Industry Canada technical specifications.
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2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to 
be connected to a telephone interface. The termination on an interface may consist of any 
combination of devices subject only to the requirement that the sum of the RENs of all the devices 
does not exceed five.

This Class B digital apparatus complies with Canadian ICES-003.

Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.

L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de terminaux qui peuvent 
être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une 
combinaison quelconque de dispositifs, à la seule condition que la somme d’indices d’équivalence de la 
sonnerie de tous les dispositifs n’excède pas 5.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the 
Epson printer covered by this limited warranty statement, if purchased and operated only in the 
United States, Canada, or Puerto Rico, will be free from defects in workmanship and materials for a 
period of one (1) year from the date of original purchase. For warranty service, you must provide 
proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the 
warranty period, please call the EPSON ConnectionSM at (562) 276-4382 (U.S.) or (905) 709-3839 
(Canada) for warranty repair instructions and return authorization. An EPSON service technician 
will provide telephone diagnostic service to determine whether the printer requires service. If service 
is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in the United States, Canada, or Puerto Rico. 
Shipments to other locations will be made freight collect. You are responsible for securely packaging 
the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If Epson authorizes repair instead of 
exchange, Epson will direct you to send your printer to Epson or its authorized service center, where 
the printer will be repaired and sent back to you. You are responsible for packing the printer and for 
all costs to and from the EPSON authorized service center. When warranty service involves the 
exchange of the printer or a part, the item replaced becomes Epson property. The replacement 
printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, 
may be another model of like kind and quality. Exchange products and parts assume the remaining 
warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States, 
Canada, or Puerto Rico. Using this product for continuous production or similar high duty purposes 
is not considered normal use; damage, maintenance or service from such use will not be covered 
under this warranty. This warranty is not transferable. This warranty does not cover any color change 
or fading of prints or reimbursement of materials or services required for reprinting. This warranty 
does not cover damage to the EPSON product caused by parts or supplies not manufactured, 
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distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party 
parts, components, or peripheral devices added to the EPSON product after its shipment from 
Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty 
service should the Epson label or logo or the rating label or serial number be removed or should the 
product fail to be properly maintained or fail to function properly as a result of misuse, abuse, 
improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and 
lightning, improper electrical current, software problems, interaction with non-EPSON products, or 
service other than by an EPSON Authorized Servicer. If a claimed defect cannot be identified or 
reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD 
IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR 
REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO 
EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE 
THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR 
ANY OTHER LEGAL THEORY.  IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE 
LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL 
PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights 
and you may have other rights which vary from jurisdiction to jurisdiction.

To find the EPSON Authorized Reseller nearest you, visit our website at: www.epson.com.

To find the EPSON Customer Care Center nearest you, visit www.epson.com/support.

You can also write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.

In addition to software program rights owned by Seiko Epson Corporation, this product also 
includes open source software. Refer to OSS.pdf on your product software CD-ROM for a list of 
open source software and software license terms applied to this printer.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any 
Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material 
in certain circumstances, those circumstances may not be as broad as some people assume. Contact 
your legal advisor for any questions regarding copyright law.

Trademarks

EPSON and Supplies Central are registered trademarks, EPSON Connect is a trademark, and 
EPSON Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

EPSON Connection is a service mark and Small-in-One is a trademark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2012 Epson America, Inc. 5/12
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